X-PLANE 10
ENTERING A FLIGHT PLAN
Welcome to the last issue of Full Circle. For 2014 that is.

Man down. Man down! After making such a triumphant return last month, Greg is ill, so no Python this month I'm afraid. Still haven't heard anything from Nicholas, so no Blender again, but there is some Inkscape. We do have a great article from Brian (the nice man who brings you the FCM EPUB every month) who shows you how to make your own Special Edition PDF. Also, a handy How-To on doing bulk printing from within Nautilus with a menu shortcut.

I've started a new Arduino project this month, and also written another X-Plane 10 article. This one is on how to plan, then enter, your flight route. I've recently bought a USB joystick card which I hope to link to X-Plane to create a real-world switch box with which to control X-Plane. If it goes well I'll (obviously!) create an article about it for FCM.

Our kernel series reaches its second-to-last article, and Charles shows how he uses SSH to graphically rename his networked collection. For reviews, we have a quick look at Scilab, and a review of the 'Build Your Own Website' book. Which is more graphic novel than text book.

This is, of course, the last FCM of 2014. I hope you've enjoyed the past eleven issues, and will continue to read on through 2015.

All the best to you, and yours, for 2015!

Ronnie
ronnie@fullcriclemagazine.org
SAY HI TO LINUX’S FUTURE: FEDORA 21 IS HERE

If you want to see where enterprise Linux is going, you should look at Red Hat’s community Linux distribution, Fedora, today. Say hello to Fedora 21’s default GNOME 3 desktop. It’s in Fedora that Red Hat explores the cutting edge of Linux and open source software developments. While not everyone will like where Fedora is going – for example, Fedora’s init system systemd still has many detractors -- it’s still the bellwether for Linux. If a software library or program isn’t in Fedora at some point, it’s not likely to ever show up in mainstream Linux.

Submitted by: Peter Odigie

DEBIAN FORKED, UBUNTU MATE FABULOUS, AND FEDORA 21 RC1

Everybody went back to work today and there is so much news I hardly know where to start. The top story tonight is bound to be the official forking of Debian. In other news, Dediomedio.com says Ubuntu 14.10 MATE is "almost fabulous" and the Free Software Foundation released their 2014 gift buying guide. Mint 17.1 is almost here and a Fedora 21 release candidate has been released. Carla Schroder has an exclusive on Linux.com about being a maker instead of a user and, finally, a bunch of too-good-to-resist tidbits.

Source: http://ostatic.com/blog/debian-forked-ubuntu-mate-fabulous-and-fedora-21-rc1
Submitted by: Arnfried Walbrecht

IMAGINATION BRINGS VIRTUALISED LINUX SECURITY TO THE INTERNET OF THINGS

Imagination Technologies has announced the creation of a tiny hypervisor rig to power its MIPS-based CPUs. The joint venture with Japanese firm Seltech saw the Fexerox hypervisor embedded firmware from Seltech paired with an Imagination MIPS5150 CPU to create a virtualised environment, allowing multiple operating systems to run independently off a single unit packed into a tiny space.

A recent demonstration at the Embedded Technology Conference in Japan showed a real-time operating system powering a motor which was completely unaffected by the booting, running and closing down of a Linux operating system on the same CPU.

Submitted by: Arnfried Walbrecht

THE IMPACT OF THE LINUX PHILOSOPHY

Whether we know it or not, most of us have some sort of philosophy of life. It may be as simple as, "Be kind to others," or it might be a very complex life philosophy.

Many companies have some sort of philosophy as well. They may be unwritten or well-documented. When I worked at IBM, from 1974 through 1995, the IBM philosophy was well-documented and strongly ingrained in the culture. IBM’s philosophy covered its business practices and how employees, customers, and suppliers were to be treated. The IBM prime directive, as it were, was to treat everyone fairly, with respect and dignity.

Before I started working with Linux in some depth, I had never known that it had a philosophy. I mean, what could a philosophy actually do for an operating system? After a bit of research, I
discovered that all operating systems have a philosophy. I also learned that the philosophy of an operating system matters.

Source:
http://opensource.com/business/14/12/linux-philosophy
Submitted by: Arnfried Walbrecth

**Linux Foundation finds enterprise Linux growing at Windows’ expense**

Sure, Windows still rules the desktop, but Linux kicks rump and takes names on enterprise servers and the cloud, according to the 2014 Enterprise End User Trends Report from The Linux Foundation and the Yeoman Technology Group.

Specifically, they found that enterprise server applications are being deployed at the expense of Windows and Unix over the last four years. Linux application deployments have risen during this period, from 65 percent to 79 percent, while Windows deployment has fallen from 45 percent to 36 percent.

This report is based on data from an invitation-only survey of The Linux Foundation’s Enterprise End User Council as well as companies and organizations with sales of $500 million or more, or 500 or more employees. The surveyed group included Morgan Stanley, Goldman Sachs, Bank of America, Bristol-Myers Squibb, NTT, Deutsche Bank, DreamWorks, ADP, Bank of New York, NYSE, NASDAQ, Goodrich, MetLife, and AIG. Of course, these companies are already invested in Linux. That said, it’s noteworthy how many Fortune 500 and financial powerhouses now put their trust in Linux for mission-critical software.

Source:
http://www.zdnet.com/linux-foundation-finds-enterprise-linux-growing-at-windows-expense-7000036365/
Submitted by: Arnfried Walbrecth

**Little Known GUI Firewall Options for Linux**

As you may know, iptables and NetFilter combine to make the most popular firewall solution in Linux. Given there’s only a native command-line interface (CLI) for the two, though, there can be a learning curve. The good news, however, is that there are many graphical user interfaces (GUIs) you can use with Linux. Let’s look at some of the most powerful yet easy-to-use options available.

Source:
Submitted by: Arnfried Walbrecth

**Linus Torvalds releases Linux 3.18 as 3.17 wobbles**

Linus Torvalds has pressed the go button for a new release of his eponymous kernel.

Linux version 3.18 was let loose on Sunday, US time, after what Torvalds wrote was a “tiny” patch to get release candidate 7 done.

The new version’s headline features for business users are better sleep and resumption for Linux servers, more support (thanks to a contributor from Samsung) for the The Flash-Friendly File-System (F2FS) and some RAID-friendly tweaks to BTRFS. There’s also lots more support for graphics devices from NVIDIA and AMD.

Torvalds’ announcement also says “I’d love to say that we’ve figured out the problem that plagues 3.17 for a couple of people, but we haven’t.”

Source:
http://www.theregister.co.uk/2014/12/08/linux_torvalds_releases_lin ux_3.18_as_317_wobbles/
Submitted by: Arnfried Walbrecth

**Powerful, highly stealthy Linux Trojan may have infected victims for years**

Researchers have uncovered an extremely stealthy Trojan for Linux systems that attackers have been using to siphon sensitive data from governments and pharmaceutical companies around the world.

The previously undiscovered malware represents a missing puzzle piece tied to "Turla," a so-called advanced persistent threat
(APT) disclosed in August by Kaspersky Lab and Symantec. For at least four years, the campaign targeted government institutions, embassies, military, education, research, and pharmaceutical companies in more than 45 countries. The unknown attackers—who are probably backed by a nation-state, according to Symantec—were known to have infected several hundred Windows-based computers by exploiting a variety of vulnerabilities, at least two of which were zero-day bugs. The malware was notable for its use of a rootkit that made it extremely hard to detect.

Source: http://arstechnica.com/security/2014/12/powerful-highly-stealthy-linux-trojan-may-have-infected-victims-for-years/ Submitted by: Arnfried Walbrecht

**Skinny Ubuntu Linux 'Snapped' up by fat Microsoft cloud**

A smartphone-inspired version of Ubuntu Server for Docker minimalists has been revealed with initial backing from Microsoft. Canonical is today expected to unveil the "Snappy" version of Ubuntu Core, a stripped-down server image of just 110MB built for thousands of servers in the cloud. It is available as an Alpha preview. The minimalist root file system is built solely for transactional jobs and applications and will début on Microsoft’s Windows Azure.

The slimmed-down Linux system is promised for other clouds before Christmas. Canonical told The Register Microsoft has proved very proactive in supporting Ubuntu Core – it’s willing to get Linux workloads up and running on its cloud. Canonical believes Microsoft is a ready market and suited to Ubuntu, given its large enterprise customer base. The Linux firm expects that plenty of enterprise jobs will now be run on Linux through the medium of Windows Azure.

Source: http://www.theregister.co.uk/2014/12/09/ubuntu_core_snappy/ Submitted by: Arnfried Walbrecht

**HP’s Big Slap in the Face to Microsoft Will Show Up Next Year**

By next June, HP will be showing off what it hopes will become the future of the operating system. And it won’t have anything to do with Microsoft or Windows. The operating system is called Linux++, and it is part of HP’s ambitious project to reinvent the computer, reports MIT Technology Review’s Tom Simonite.

Ultimately, HP hopes to replace Linux++ with something even more radical and homegrown, an operating system called Carbon, though it hasn’t announced a timeline for that. This is all part of HP’s plans to build "The Machine," a computer so radical and so powerful that it will reduce today’s data center down to the size of a refrigerator.


**U.S. Marine Corps Wants to Change OS for Radar System from Windows XP to Linux**

When it comes to stability and performance, nothing can really beat Linux. This is why the U.S. Marine Corps leaders have decided to ask Northrop Grumman Corp. Electronic Systems to change the operating system of the newly delivered Ground/Air Task-Oriented Radar (G/ATOR) from Windows XP to Linux.

It’s interesting to note that the Ground/Air Task-Oriented Radar (G/ATOR) was just delivered to the U.S. Marine Corps, but the company that built it chose to keep that aging operating system. Someone must have noticed the fact that it was a poor decision and the chain of command was informed of the problems that might have appeared.

MAJOR NVIDIA STABLE DRIVER RELEASED

A fresh NVIDIA driver for the Linux platform has been released and it looks like the devs have made a number of changes and important improvements that really stand out.

NVIDIA seems to be the only company that takes the Linux community seriously, or at least this can be deduced from the changelogs and the number of drivers that are released for the platform. AMD and Intel do their share of work with the kernel, but it’s nowhere near the kind of dedication that NVIDIA has. The simple fact that they release often is proof that they really do care about their users.

Submitted by: Silviu Stahie

OPERAS 26 RELEASED. INSTALL IT ON LINUX MINT 17.1 AND UBUNTU 14.10

I don’t quite remember the last time I used Opera browser, but it’s been a very long time ago. I didn’t even think that the company is still developing a Linux version.

So, surprised I was when I read that Opera 26 has been released for Windows, Mac and Linux. Even more surprising is this line from the FAQ about Opera Linux: “Yes, all of the major features found in Opera for Windows and Mac are also available to Linux users, including: Speed Dial, the Discover feature, Opera Turbo, bookmarks and bookmark sharing, themes, extensions and more.”

Source: http://www.linuxbsdos.com/2014/12/04/ope4a-26-released-install-it-on-linux-mint-17-1-and-ubuntu-14-10/
Submitted by: LinuxBSDos

ELIVE OS IS A UNIQUE DEBIAN AND ENLIGHTENMENT COMBO

Elive, a Linux distribution based on Debian that uses the Enlightenment desktop environment to provide a unique user experience, is now at version 2.4.6 and the developers are getting closer to a stable release.

Elive is a different kind of operating system and it will require the user to be a little open-minded because this distro provides an interesting desktop experience. There are very few OSes out there that even share the same kind of desktop, so it’s easy to say that it provides something unique.

The Enlightenment DE is mostly responsible for this, but it’s also the devs merit who managed to make all the necessary changes to turn this into something special.

Submitted by: Silviu Stahie

YEAR END CORE APPS HACK DAYS ANNOUNCED FOR UBUNTU TOUCH

Canonical is looking to improve the core apps that are already available for Ubuntu Touch and is organizing a new Core Apps Hack Days event that should galvanize the efforts of more developers towards this platform.

Native apps are what Ubuntu Touch needs more than anything and that’s because the team can only deal with the operating system, but the rest of the ecosystem has to come from third-party developers who need to take the rest of the journey.

The guys and gals who build Ubuntu Touch do provide a number of apps, like the Gallery or the Browser, but they can’t spread their efforts in all the directions. This is where Core Apps Hack Days comes into play.

Submitted by: Silviu Stahie
Dota 2 Runs Natively on Mir with the Same Performance as X11

Canonical has been working on the Mir display server for some time, although most of their efforts have been made towards the mobile platform. They are now looking to optimize it for desktop use and nothing reflects the progress made more than a famous game running on Mir.

Mir is already working on the desktop, but users need to have the open source video drivers in order to make it work. Canonical has recently built a new flavor called Ubuntu Next which features Unity 8 and the Mir display server. The new desktop environment needs Mir, so it stands to reason that the updated DE will arrive for regular users when Mir is also ready. It’s not there yet, but it’s taking great strides.

Submitted by: Silviu Stahie

Dropbox 3 for Linux Goes Stable With New Qt UI, Setup Wizard

The “problem” with new releases of Dropbox is that most are virtually identical to the last. While good in that no senseless changes arrive solely for change’s sake, it’s bad in that it makes for very droll “news” coverage!

Thankfully this release does have a bit more meat on its free range bones. As we showed you back in July, the UI changes in Dropbox 3.0.x are noticeable — and not just because the blue panel icon is now white! ;)

Another change making the jump from the July preview is the all-new setup wizard. Nothing too fancy here, but a big reduction in the number of hoops one jumps through on a fresh install.

Source: http://www.omgubuntu.co.uk/2014/12/dropbox-3-0-3-stable-linux-desktop-build-released

Why is the Number of Linux Distros Declining?

The number of Linux distributions is declining. In 2011, the Distrowatch database of active Linux distributions peaked at 323. Currently, however, it lists only 285. However, exactly why the decline is taking place and how much it matters remains unclear.

Distros have always come and gone. In fact, Distrowatch lists 791 distributions that have existed since it was founded in 2001, although less than forty percent have ever been in active development at any given time. These tallies may not be complete, since some distributions probably never register with Distrowatch, but they are as accurate as anyone is likely to offer.

But until about 2011, the number of active distributions slowly increased by a few each year. By contrast, the last three years have seen just a 12% decline -- a decrease too high to be likely to be coincidence. So what’s happening?

Source:

Submitted by: Arnfried Walbrecht

Green Hills Challenges “Rudimentary” Linux Debug

Green Hills Software has announced a software development environment for embedded Linux developers.

According to Green Hills, the Linux development software in its MULTI tool suite will address the “rudimentary” state of many debuggers for Linux, which it said were “difficult to learn, setup, and use and lack the powerful control and visibility that modern electronic systems demand”.

Green Hills said it is possible with MULTI to control and debug all aspects of an embedded Linux system, including the Linux kernel, kernel threads, user mode threads and processes, and interrupt service routines (ISRs), all from a single tool, in a single window or in separate windows per instance.

Source:

http://www.greenhills.com/blog/2014/08/20/green-hills-challenges-rudimentary-linux-debug/
THE 'GRINCH' ISN'T A LINUX VULNERABILITY, RED HAT SAYS

The "grinch" Linux vulnerability that Alert Logic raised alarms about Tuesday is not a vulnerability at all, according to Red Hat.

"This report incorrectly classifies expected behavior as a security issue," said a Red Hat bulletin issued Wednesday, responding to Alert Logic's claims.

Security firm Alert Logic Tuesday claimed that grinch could be as severe as the Heartbleed bug and that it's a serious design flaw in how Linux systems handle user permissions, which could allow malicious attackers to gain root access to a machine.

Alert Logic claimed that an attacker could exploit grinch through the use of a third-party Linux software framework called Policy Kit (Polkit), which was designed to aid users in installing and running software packages. Red Hat maintains Polkit, an open-source program. By allowing users to install software programs, which usually requires root access, Polkit could provide an avenue to run malicious programs, inadvertently or otherwise, Alert Logic said.

But the system was designed to work that way -- in other words, grinch is not a bug but a feature, according to Red Hat.

Submitted by: Arnfried Walbrecht

YEAR OF THE PENGUIN: A LINUX MOBILE IN 2015?

It's nearly impossible to sum up an entire year of developments in something as large and nebulous as the world of desktop Linux, especially in a year like this one which has seen some of the best releases that projects like Mint, Fedora and openSUSE have put out to date.

At the same time the distro that's closest to being a household name, Ubuntu, has been nearly silent since 14.04 arrived in April.

To paraphrase author Charles Dickens, the past year of Linux releases has been both the best of times and the worst of times.

At the very moment that Linux desktops seem to be reaching new levels of sophistication, polish and "just works" ease-of-use, the entire future of the desktop computer (by which I also mean laptop) feels in doubt.

No, the desktop is not dead yet, but it increasingly feels as though, for the general use case anyway, the mobile device offers most of what the user needs.

A tablet may not be top of the holiday wish list for self-professed power users, but for most it's enough to check email, browse the web and upload some images. Combine that with better battery life, smaller, lighter form factors and you can understand why Canonical spent the better part of year working on its mobile interface.

Editors note: The long awaited Ubuntu Phone will be released to insiders in early February 2015. I hope to have one for unboxing and review by mid-February. Stay tuned!

Source: http://www.theregister.co.uk/2014/12/22/linux_year_review/
Submitted by: Arnfried Walbrecht
Last month, we talked about Jee, and I mentioned Stylus. Since then, I’ve also started using Flexbox on a few websites. After a single website, I was tired of writing all the vendor prefixes by hand, and designed a Stylus file containing functions to minimize the amount of typing needed. Once I got it to a point where I was happy, I published it on github.

Link: https://github.com/lswest/flexbox-stylus

**What you’ll find there**

- Folders with css and stylus files
- A LICENSE file
- Readme.md
- flexbox.html file

The flexbox.html file and the css folder are used only as an example. In the stylus folder, you’ll see an example.styl folder, as well as a flexbox.styl file. The flexbox.styl file is the only file you need to copy to use the functions.

**What is Flexbox?**

Flexbox is a new layout system introduced in CSS3, and is currently supported in one form or another in most commonly used versions of Firefox, Chrome, Safari and Opera. It’s also supported by IE 10 & 11. See here for a thorough breakdown: http://caniuse.com/#search=flexbox

Flexbox makes it easy to align elements (vertically and horizontally), as well as having elements grow/shrink according to the size of the parent. Best of all, it’s possible to adjust the ordering of elements in CSS alone. That means your left-handed sidebar can come after your content element on smartphones, instead of being forced to work with floats or display: none.

Links:
- http://the-echoplex.net/flexvboxes/- A tool to help figure out your flexbox settings.

**Usage**

Just place the flexbox.styl file into your project, then import it in your stylus file with @import 'flexbox' Each function tries to accept as many official values (according to the Flexbox standard), but does require some changes.

**Functions**

- flexbox(value) where value is either flex, or inline-flex.
- flex(size, grow, shrink, basis) Each value, except grow, is optional. Size is used for a width attribute (for legacy browsers). To set only the grow value, use flex(grow: 1). The same format can be used to set any specific arguments.
- flex-direction(value) value can be: row, row-reverse, column or column-reverse - Function for Flexbox’s flex-direction
- flex-wrap(value) Accepts the 3 options: nowrap, wrap, wrap-reverse - Function for Flexbox’s flex-wrap
  - flex-justify(value) value can be: start, end, center, space-bottom or space-around - Function for Flexbox’s justify-content
  - flex-content(value) value can be the same options as for flex-justify(value) - Function for Flexbox’s align-content
  - flex-align(value) value can be: start, end, stretch, center, baseline - Function for Flexbox’s align-items
  - flex-self(value) accepts start, end, auto, center, baseline, stretch - Function for Flexbox’s align-self
  - flex-group(value) accepts any positive number - Function for Flexbox’s order attribute
  - flex-firefox() Helper function for legacy Firefox (where Flexboxes were treated as inline items). Place it inside the firefox-only selector (@-moz-document url-prefix()). See the example.styl file for an example.

**Holiday Bonus**

And, due to the time of the year, I have a useful little hint for
import csv # library to handle reading csv files

with open('contacts.csv', 'r', encoding="utf-8") as f: # open a file with UTF-8 encoding
    lines = csv.reader(f) # read the csv file
    your_list = list(lines) # create a list from the csv file entries

addresslist = open('files/addresses.txt', 'w')

for item in range(1,len(your_list)): # for each item in the list
    name = your_list[int(item)][0]
    position = your_list[int(item)][60]
    companyName = your_list[int(item)][58]
    address = your_list[int(item)][41] + "\n"
    if any(c.isalpha() for c in your_list[int(item)][45]):
        address += your_list[int(item)][42] + " " + your_list[int(item)][45] +"\n"
    else:
        address += your_list[int(item)][45] + " " + your_list[int(item)][42] +"\n"
    addresslist.write(name + "\n") # write the name to the file
    addresslist.write(position + "\n")
    if companyName != "": # if the company name exists
        addresslist.write(companyName + "\n")
    addresslist.write(address + "\n\n") # write the address to the file
addresslist.close() # close the file

The only bit of information from the csv necessary for this to work is the position of the fields you want to use in the address (i.e. the name field is the first one, it’s position 0). You can save these in variables if you want to.

A rough outline (not a working program) is shown top right.

This creates a list where each element is another list containing the values of the fields for that line of the csv file. In other words - it’s a two dimensional list. I iterate over the list using the following code,

and then write the necessary sections to the addresses.txt file.

Once the file is created, you can copy the text into another program to format it (or print it directly on the envelopes or on labels).

A complete copy of a working script can be found here: http://pastebin.com/bZmanQAc. The only changes necessary will be to the index variables, according to the CSV file you want to implement.

I hope this has been interesting for at least some users - and perhaps sending large numbers of cards in the new year will be easier.

If you have corrections, questions, comments, or suggestions, I can always be reached at lswest34+fcm@gmail.com.

Lucas has learned all he knows from repeatedly breaking his system, then having no other option but to discover how to fix it. You can email Lucas at lswest34@gmail.com.
Greg is feeling a bit under the weather this month, but hopefully he’ll be well enough to return for FCM#93.

Way back in FCM#82 in a letter Arick wrote “On that note, I’d like to see a compilation for the GIMP articles. That was also an exceptional series.”

You don't have to wait for a compilation as you can make your own quite easily. There are several ways but, for this article, I've chosen to use PDF Mod which is in the repositories. Open Synaptic and search for it there.

The next thing to do is to search through the Index of issues to find which ones contain the articles you are interested in.

Issues containing GIMP-related articles are 6, 12, 13, 14, 15, 16, 17, 18, 19, 60, 61, 62, 63, 83. I might have missed some so double check.

Open the first one in PDF Mod (shown below left).

Articles don’t always allow us to select every page we want easily, so, in this case, right-click on the first page of the article and select 'extract'.

If we now go back to our article we can select the other two pages and highlight and extract them.

If we now left-click our solitary page we can drag it across to where we want it.

The final step is to rename our first part of the compilation and save it in a new folder – in this case I've called it Grub1a and saved it in a Temp folder.

The file that contained the single page can now be closed.
Finally save it as Collected GIMP (shown below).

If you intend to use a collection of articles, please abide by copyright rules (CC-SA) as published in the magazine (page 2) each month.

Or, better still, send it to us here at FCM and we’ll host them on the site for others to download.

without saving and we can move on to extracting the next article.

I now have 14 files which I need to make into one file, plus, it would be nice to have a cover.

It’s easy to make a .pdf cover page using either Scribus or LibreOffice and it can be as simple or complex as you wish.

Now open Gimp14 in PDF Mod (shown above). This time we are going to add the folders we created previously.

Click on the + symbol and add each folder – working back from 13 to the cover. The reason for working backwards is that each file is added before the existing files.

The Ubuntu Podcast covers all the latest news and issues facing Ubuntu Linux users and Free Software fans in general. The show appeals to the newest user and the oldest coder. Our discussions cover the development of Ubuntu but aren’t overly technical. We are lucky enough to have some great guests on the show, telling us first hand about the latest exciting developments they are working on, in a way that we can all understand! We also talk about the Ubuntu community and what it gets up to.

The show is presented by members of the UK’s Ubuntu Linux community. Because it is covered by the Ubuntu Code of Conduct it is suitable for all.

The show is broadcast live every fortnight on a Tuesday evening (British time) and is available for download the following day.

podcast.ubuntu-uk.org
When you begin to create formulas in Calc, you soon realize that the wrong kind of data in a cell referenced by your formula can throw the results off. Calc does its best to interpret the data entered according to the formatting style of the cell. If you format the cell as a date type, Calc does its best to translate the input in that cell as a date. At times it is successful and other times not. Fortunately, Calc comes with validity options built in to help you design your spreadsheet in such a way as to give the user help with the input or even force them to enter the data type needed for the cell. In this article, we will look at the validity options and its capabilities.

**Sheet Setup**

Before we get to the validity options of Calc, we need to set up a spreadsheet where we will use the options. The spreadsheet is a time sheet for showing the hours worked during a week. The time sheet works well for our example because on a given day, the next time input must have a greater value than the previous entry.

We will start by creating our title and column headers. In cell A1, enter “Time Sheet”. On row 2, fill in columns A-F with the following titles: DAY, IN, OUT, IN, OUT, TOTALS. Now for the row headers. In cell A3, type in “Sunday”. Making sure that cell A3 is highlighted, click on the small square in the lower right corner of the highlighted cell. The cursor will become a crosshair. Drag down to A9. When you release mouse button, the rest of the weekday names are filled in. This happens because the days of the week are one of the default sort lists. You can see all the lists and add your own at Tools > Options > LibreOffice Calc > Sort Lists.

Now let’s format the cells. Select B3:E9, right-click, and select Format Cells. Click the Numbers tab. From the Category list box, select Time. If you normally use a 12-hour clock, select the “01:37 PM” option under format. However, for a 24-hour clock, select “13:37.” Click OK to save the options. Column F is the totals. We will need to select a time format, at least for the last one, that can go beyond 24 hours. Select cells F3:F10, right-click, select Format Cells. Again, on the Numbers tab, select the Time category, but for the format, select “876613:37.” This will allow for totals that are greater than 24 hours. Click OK to save the settings.

If you haven’t yet, you might want to save your sheet.

**Setup Validation**

We will need to check the validity of the time inputs. We will want them in a Calc-acceptable time format. This is the only requirement for valid data in the B column. For the other columns (C-E), we will need to also make sure the input is greater than the input before it.
Select cell B3, then Data > Validity. The Validity dialog will appear.

The Criteria tab (above) is where we control what constitutes valid data. The Allow drop-down list defines the type of data that is acceptable. The default is All Values. The other types are Whole Numbers, Decimal, Date, Time, Cell Range, List, and Text Length. The choices for the different types are basically the same except for Cell Range and List. With the cell Range, you define a cell range and the cell must contain a value that is in one of those cells. The defined range must consist of only one column or one row. With the List option, you define a list of acceptable values. With both the List and Cell Range options, you get a drop-down list box with the acceptable values. For our purposes, we need Allow set to Time.

Check the box for “Allow empty cells” to allow cells to remain empty. This will allow us to start with a blank time sheet.

The Data drop-down list allows you to select the comparative operator to use for this validation. The choices are equal, less than, greater than, less than or equal to, greater than or equal to, not equal, valid range, and invalid range. Each one asks for a minimum, maximum, or value to compare, except for the two range choices. The range choices require a minimum and maximum. For our purpose, we need the greater than operator. In the minimum text box, enter 12:00 AM or 00:00.

Click on the Input Help tab (below). The settings on this tab are optional. The idea is to provide the user with information about what to enter into the cell as a tip box that pops up when the cell is selected. To activate, click the checkbox for “Show input help when cell is selected.” Create a title for the tip box by typing it in the Title text box. For us, we could use the title “Start Time”. The Input Help text box is where you put the actual help tip like “Enter the start time: ex. 1:00 PM or 13:00”.

Switch to the Error Alert tab (above). Here we can set the validation to display a message when invalid data is entered. To activate the setting, check the checkbox for “Show error message when invalid values are entered”. There are four choices for the Action drop-down list, Stop, Information, Warning, and Macro. Stop, the one we will use, prompts with a dialog and rejects the input.
HOWTO - LIBREOFFICE

when invalid data is entered. For Information and Warning, they prompt with a dialog containing OK and Cancel buttons when invalid data is entered. If the user clicks OK, the input is left as it is. If the user clicks Cancel, the input is rejected. Macro will allow you to select a macro to run when invalid data is entered. The Title and Error Message is the title and message for the dialog box. We could set them to “Invalid Time” and “Enter in time format: 13:00 or 1:00 PM”.

Once you have everything set, click OK to save the Validity dialog settings.

We will copy cell B3 to cells B4:B9. Right-click cell B3 and select Copy. Select cells B4:B9, right-click, and select Paste. This will copy the validity settings to the cells. The whole column will have the same requirements for input.

For columns C, D, and E, we will do almost the same thing. We will go through the steps on C, and you can repeat for D and E. Select cell C3, Data > Validity. On the Criteria tab of the Validity dialog, select Time from the Allow drop-down list. Check to allow empty cells. Set Data to greater than, and set the minimum value to B3. Notice that we use a relative cell reference here. This will allow us to copy it to the other cells and have the reference translate. These criteria tell Calc that the cell requires a value greater than the value in cell B3. Do what you want with the help and error tabs. I do recommend using at least Information or Warning messages for invalid data. The messages could mention needing a greater value (or a later time). Right-click cell C3 and copy the cell, then paste it into cells C4:C9.

You can repeat for columns D and E. You can also just copy C3 to D3:D9 and E3:E9, but you will need to adjust the text in the dialogs for help and error.

TOTAL FORMULAS

Now that we have our validation set up, we need to create the formulas to give us our totals. We will start with the daily totals. Select cell F3. Enter the formula

= (C3−B3) + (E3−D3)

which will give us the total for Sunday’s times. Right-click F3 and Copy. Select cells F4:F9, right-click, and Paste.

For the weekly total in F10, we will just sum the daily totals. Here is the formula:

=SUM (F3 : F9)

PROTECT CELLS

Once you have a sheet set up the way you like, you may want to protect the parts of the sheet you don’t want changed like the labels and formulas. First, you need to tell Calc whether the cell is protected or not. Then you add protection to the sheet or document once everything is finished. In the case of our time sheet, we need to protect everything except for the cells where the user enters their times, B3:E9.

By default, the Protect option is turned on for all cells. To change the protection setting for the input cells, select B3:B9, Format > Cells, and the Format Cells dialog appears. Click on the Cell Protection tab and uncheck Protected.

At this point, you can still edit any cell because the sheet or document is not protected. To turn on protection for the sheet or document, Tools > Protect Document > Sheet (or Document). The Protect Sheet or Protect Document dialog will appear depending on which option you selected. Enter and confirm a password in the dialog. The options will allow you to check whether the user can select protected or unprotected cells. If you do not enter a password, then no password is required to remove protection from the sheet or document.

To remove protection from a sheet or document, Tools > Protect Document > Sheet (or Document). If a password was used when protection was set, enter the password used to protect the sheet or document.
**MARK INVALID DATA WITH DETECTIVE**

If you selected Warning or Information from the Action dropdown list in the Validity dialog, a user could enter invalid data and click OK to keep the invalid input. This may generate strange results in your totals or an error. Tools > Detective > Mark Invalid Data will mark the invalid data. Once the user corrects the data, Tools > Detective > Mark Invalid Data should clear the marks, unless the data is still invalid. Notice from my sample that invalid data can cause other cells data to show as invalid.

The Calc Validity options are a great way to set up sheets for use by other people, or to keep you from entering invalid data on a complicated sheet. You can set it up to reject the invalid data outright, or for the user to make a choice about keeping the input. Once you have the sheet set the way you want it, you can protect the sheet from unwanted changes. This is a good way to protect formulas and labels. Finally, the Detective tool allows the user to mark invalid data they entered.

<table>
<thead>
<tr>
<th>DAY</th>
<th>IN</th>
<th>OUT</th>
<th>IN</th>
<th>OUT</th>
<th>TOTALS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sunday</td>
<td>08:00 AM</td>
<td>01:15 PM</td>
<td>02:15 PM</td>
<td>05:00 PM</td>
<td>08:00</td>
</tr>
<tr>
<td>Monday</td>
<td>08:00 AM</td>
<td>09:00 AM</td>
<td>12:00 PM</td>
<td>05:00 PM</td>
<td>06:00</td>
</tr>
<tr>
<td>Tuesday</td>
<td>09:00 AM</td>
<td>12:00 PM</td>
<td>01:00 PM</td>
<td>05:00 PM</td>
<td>07:00</td>
</tr>
<tr>
<td>Wednesday</td>
<td>08:00</td>
<td>05:00</td>
<td>13:00</td>
<td>12:00</td>
<td>20:00</td>
</tr>
<tr>
<td>Thursday</td>
<td>09:00</td>
<td>12:00</td>
<td>16:00</td>
<td>07:00</td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>08:00</td>
<td>12:00</td>
<td>16:00</td>
<td>07:00</td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td>09:00</td>
<td>11:00</td>
<td>12:00</td>
<td>18:00</td>
<td>08:00</td>
</tr>
</tbody>
</table>

**Total** #VALUE!

---

Our glorious news reporters are now posting regular news updates to the main Full Circle site.

Click the NEWS link, in the site menu at the top of the page, and you’ll see the news headlines.

Alternatively, look on the right side of any page on the site, and you’ll see the five latest news posts.

Feel free to discuss the news items. It’s maybe something that can spill back from the site into the magazine. Enjoy!
Let's suppose that you have a lot of ODT (Libreoffice Writer) files, and you need to print them all.

Opening each file and clicking on the Print icon could be the right way if the files are three or at most four, but what if you have twenty, fifty, hundreds of files to print all at once?

If you are a command-line lover, probably there is not any problem. In fact you can invoke a command like the following, maybe from inside a loop:

```bash
for file in *
do
  libreoffice --pt [printer_name] file_to_print.odt "$file"
done
```

But if you are afraid of the command-line, or if you want to allow a dummy user to print a bunch of files, the solutions could be more than one, as usual.

The most elegant solution that I have found, consists in the use of a software named Nautilus-Actions. As stated by the “apt-cache show” command: Nautilus actions is an extension for Nautilus, the GNOME file manager. It allows the configuration of programs to be launched on files selected in the Nautilus interface. Obviously Nautilus-Actions is not limited to bulk printing.

With such software, you can easily create entries in the context menu that appears when you right-click on a file in the Nautilus file manager.

Let's go back to our goal: configure a context menu entry that directly prints a Libreoffice Writer file without the need to open it.

First of all, you need to install the package (using apt-get or the Ubuntu software center or Synaptic):

```
sudo apt-get install nautilus-actions
```

Now launch the program. An intuitive and self explanatory interface should appear.

Now go to “File” and select “New action” (or click on the related icon).

In the “Action” folder, define a “Context label”, let's call it “Print”.

In the “Command” folder, then in the “Command” section, fill in the “Path” field with the path to the Libreoffice executable: /usr/bin/libreoffice
HOWTO - NAUTILUS ACTIONS

In the “Parameters” field, put the libreoffice parameter “--pt” (followed by the optional printer name to use if you don’t want to print on the default one).

Now, if you don’t want to show the “Print” context menu on all the kinds of files, you must use a filter on the file name (more precisely on the extension) or on the MIME type. Here we will use the file extension, just to keep things simple.

In the “Basenames” folder, delete the default entry (by way of the “-” icon), and add (by way of the “+” icon, of course) a filter: “*.odt” as the Basename filter, and click on the “Must match one of” radio button. In this way, the Print menu will appear only for the files containing the “.odt” at the end (commonly known as the file extension).

Let’s save, exit from the program, and open the directory containing the bunch of ODT files.

You can select just one file just to test, or even all the files, then you must right-click with the mouse, and a new entry should be in place: Print.

If you select a file that doesn’t have the “.odt” extension, the custom context menu entry should not appear.

The above configuration is somewhat simplistic, we will not dive into a more advanced configuration.

However there are many possibilities. For instance you can associate an icon to your action, you can define a context menu entry only for certain folders, or you can create an entry with many subentries.

Python Special Editions:

http://fullcirecmagazine.org/issue-py01/

http://fullcirecmagazine.org/issue-py02/


Get *unlimited access* to a cutting-edge technology and business library with **Apress Access**!

For **$199**

**YOU GET:**
- Unlimited access to Apress titles for a full year
- Instant access to each new Apress publication
- Compatibility with any device—desktop, laptop, or mobile
- Use of our new exclusive-to-Apress reader with unparalleled search functions
- Option to download any eBook for just $4.99 for a limited time

www.apress.com | @apress

Want more info? Check out [www.apress.com/subscriber](http://www.apress.com/subscriber)
Let's start with a familiar image to which we'll apply a clipping path. Remember, all the parts inside the bright green clipping line will remain visible once the clip is applied, whereas those outside it will be hidden.

Having clipped our image down to just show her head, what if we then decide we also want the hands? We could release the clip and construct a more complex path that includes the hands as well, before re-clipping. But that still leaves us with a single object, with the head and hands at a fixed distance apart. If we want to move the hands independently of the head – or maybe scale or rotate them – we're out of options.

The next obvious approach would be to import the image a second time and clip it to show the hands. Now we have two images, each clipped differently, resulting in two separate objects that can be modified independently. With a linked image, that might be a reasonable approach, but if our images are being embedded so that the resultant SVG can be shared more easily, we've now got two large bitmap images bloating our file. What we really want is a way to include the image just once, but create two completely separate clips from it.

From the introduction, you've probably already deduced that the answer is to group our image before clipping it. Here I've denoted the group with a dotted box for illustrative purposes – it doesn't appear in a real drawing.

The result (below right) doesn't look altogether different from our first attempt, but that's because the effect is not a visual one, but rather a structural one. Previously, our clipping path was applied directly to the image. If you were to look in the XML Editor you would see that the image has "clip-path" attribute whose value is the ID of a path stored in the <defs> section of the XML file. With the image grouped and then clipped, however, the clip-path attribute is...
now on the group itself and the image either has no clip-path attribute at all, or its value is set to "none".

The difference is subtle, but useful. By clipping the group, we've effectively created a window through which we're viewing just a part of the image at any time, but the image itself is still the full size. We can demonstrate this by double-clicking to enter the group, then dragging the image around. We're moving the un-clipped image inside the clipped group, not moving the group itself, and the effect is quite different. You could also scale, rotate or skew the image if you want, all without the size or shape of the "window" being affected.

It's a useful trick in its own right – combined with performing an "object to path" on your clipping path before the clip is applied (see Part 13) the simple expedient of grouping your image before clipping means that you can not only change the clipping path itself without releasing it, but you can also move the focal point of the content within it. Clearly you could move the image like this to bring the hands into view through the "window", but that still doesn't get us two separate clips. For that we need to get a little devious.

The steps we'll be taking aren't difficult, but they do need to be done in the right order. Once you've done it a few times, it will become second nature to you. To make things clearer, I suggest starting with a new file, and opening the XML Editor so that you can see exactly what's happening at each step in the process.

**Step 1:** Drag and drop your image into the document. I chose to embed the image to really prove the point, but linking works as well. In the XML Editor you should see an <svg:image> tag with an "xlink:href" attribute. If you've embedded the image, then the attribute will contain a Base64 encoded version of the image's binary content (if you linked the image it will contain the path to the original image).

**Step 2:** Group the image. An <svg:g> element will appear in the XML Editor – expand it out to see that your image is still inside it.

**Step 3:** Draw your clipping path. You should see it appear in the XML Editor as a sibling of the group.

**Step 4:** Select both the path and the group, then apply the clipping path using either Object > Clip > Set, or by selecting "Set clip" from the right-click context menu. Note the effect in the XML Editor: your path is moved into the <svg:defs> section, and the group gains a "clip-path" attribute that references the path by its ID.

**Step 5:** Double-click to enter the group, and select the image. Keep an eye on the status bar to confirm what's happening, and the XML Editor should also highlight the image's entry.

**Step 6:** Clone the image using Edit > Clone > Create Clone, or by pressing ALT-D. Note in the XML Editor that an <svg:use> element is created with an "xlink:href" attribute that references the image by its ID. That's your clone! No matter how complex the parent object is, a clone is actually always just a simple little <svg:use> element that holds a reference to the original.

**Step 7:** Currently you have an image, and a clone of that image, both inside a single group. Let's put the clone somewhere more useful. With the clone selected, use Edit > Cut or CTRL-X to remove it from the document (watch it vanish from the XML Editor before your very eyes), and put it on the clipboard. Remember, what we've actually put on the clipboard is just a small <svg:use> element, not the heavyweight binary data of the
Step 8: Inkscape doesn’t really care where we paste the clone, so long as the ID it references still exists in the document. So double-click on the background until the status bar tells you you’re out of the group, then use Edit > Paste or CTRL-V to paste the clone into the document.

Step 9: If everything went well you should now be looking at another, un-clipped copy of your image. Remember, the clip was applied to the group, but we’ve taken our clone from a lower level, before the clip has been applied, giving us access to the original image again but without requiring a second copy of all that binary data.

Step 10: There’s nothing special about this clone – you can treat it as you would any other. That means you can clip, mask, group, rotate, skew or blur it, and much more besides. So let’s complete our original task, and clip it to show just the hands.

There you have it – two different clips of the same image, with just a single copy of the binary data embedded into your document. Of course you don’t have to stop at two copies, you can add as many clones as you like. Each one only adds a tiny amount to the document size, but gives you a complete copy of the original image to work with.

Although I’ve demonstrated this technique with clipping, it works equally well with masking, allowing you to use all the fine control over opacity that masking provides (see Part 14 for more details). You can even mask some clones whilst clipping others to produce something like this information sheet that uses only a single embedded image.

As I mentioned in step 8, Inkscape doesn’t really care where you paste the clone. In the examples above I’ve simply pasted it outside of the original group, but you could also paste it into a different group entirely – even one that is, itself, clipped or masked. And don’t forget that layers are just groups with some extra metadata. There’s nothing to stop you cutting a clone to the clipboard (even one that’s not in a group), then switching to a different layer before pasting.

Don’t think that this technique is limited to bitmaps either. As you know, any Inkscape object or group can be cloned, and equally any can be put into a group. So you could draw a complex character or scene, group it (let’s call that “Group 1”), then group it again (“Group 2”). Clip or mask Group 2 and you can still enter the group, clone Group 1, cut it to the clipboard, and use it elsewhere in your drawing.

I use this technique a lot when creating comic strips. Typically I add some movement to a comic by zooming or panning the scene between frames, but rather than copy or redraw the background and characters I usually use clones that are then scaled as necessary before being clipped to fit in the frame. With this approach, any changes to the originals are automatically propagated to the clones, so I don’t need to update multiple panels each time there’s a tweak to be made. This strip, for example, really consists of only one panel (the top one), with the background being cloned and clipped to create the second two panels, and the heads added in different poses on top to introduce a little more variety. Finally the text was added in a separate layer to produce the finished comic.
This month I begin creating a project that may well come in useful, and practical! My dad has just bought some chickens and wants an automatic way to open and close a coop (sliding) door when it gets light or dark. Enter the Arduino!

Rather than dismantle my precious laser trip wire, I’m using one of several Arduino Nano’s that I bought from China via eBay. They were only a couple of pounds each, and do the exact same job as the Arduino Uno, except they need to be mounted on breadboard or veroboard as they have no sockets for wires, only bare pins.

So, basically what I need is to pull a wire (to open the sliding door) when it gets daylight and release the wire (to close the door) when it gets dark. That means I definitely need a servo, a 100uF capacitor, a light dependent resistor (LDR with a 10k ohm pull-down resistor), and I’ll probably use a couple of LED’s (one red, and one green with a 220 ohm pull-down resistor each) to signal the door status.

My main problems thus far are:

- the servo is always on when the door is open. I need to find a way to hold the wire but stop the servo from whirring as it will inevitably burn out the servo.
- the day/night settings are hardwired into the code. It’d be nice if there was maybe a pot to adjust the settings.

The code (at: [http://pastebin.com/WMaXNkC](http://pastebin.com/WMaXNkC)) isn’t too complex. Pre-setup(), I’m initialising the servo, my settings for sun-up and sun-down (for the LDR), the servo angle for the door open/closed, and the pins for the LEDs.

The setup() is assigning the servo pin number and setting it to zero, gives the pin modes for the LEDs (and what to initially set them at), and then uses the serial port so that I can get the LDR values.

My loop() is to read the LDR, then check to see if the light is near the sun-up value, and, if it is, to open the door, turn the red LED on, the green LED off, and delay for two seconds. Same idea, but in reverse, for sun-down.

I’ll keep you updated as to whether I can fix the servo problem, or if I move onto a new project next month.

Ronnie is the founder and (still!) editor of Full Circle. He’s a part-time arts and crafts sort of guy, and now an Arduino tinkerer.
GUIDELINES

The single rule for an article is that it must somehow be linked to Ubuntu or one of the many derivatives of Ubuntu (Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles, but be advised that long articles may be split across several issues.

• For advice, please refer to the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

• Write your article in whichever software you choose, I would recommend LibreOffice, but most importantly - PLEASE SPELL AND GRAMMAR CHECK IT!

• In your article, please indicate where you would like a particular image to be placed by indicating the image name in a new paragraph or by embedding the image in the ODT (Open Office) document.

• Images should be JPG, no wider than 800 pixels, and use low compression.

• Do not use tables or any type of bold or italic formatting.

If you are writing a review, please follow these guidelines:

When you are ready to submit your article please email it to: articles@fullcirclemagazine.org

TRANSLATIONS

If you would like to translate Full Circle into your native language please send an email to ronnie@fullcirclemagazine.org and we will either put you in touch with an existing team, or give you access to the raw text to translate from. With a completed PDF, you will be able to upload your file to the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS

When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

HARDWARE

When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.
Access all your data in one de-duplicated location
Configurable multi-platform synchronization
Preserve all historical versions & deleted files
Share folders instantly in web ShareRooms w/ RSS
Retrieve files from any internet-connected device
Comprehensive 'zero-knowledge' data encryption
2 GBs Free / $10 per 100 GBs / Unlimited devices

https://spideroak.com

Whether you need to access a document you have stored on a remote server, synchronize data between a Mac, Windows or Linux device, share important business documents with your clients, or just rest easy knowing all of your data is safely, securely, and automatically backed up - SpiderOak's free online backup, online sync and online sharing solution can handle all your needs!

SpiderOak offers a different approach to online backup by combining a suite of services into one consolidated tool - free online backup, synchronization, sharing, remote access, and storage. This difference is further measured in our zero-knowledge privacy policy - the first one ever employed in this setting. Our flexible design allows you to handle data from any operating system (Mac, Windows and Linux) or location (external drives, network volumes, USB keys, etc...) using just one centralized account.

Download mobile clients for iOS & Android

Get 25% off any SpiderOak package with the code: FullcirclemagFans
In the last installment of our series, we went through a case study in which we configured, compiled and installed a bespoke kernel for the eeePC. This small, lightweight but quite outdated notebook still can be actually useful from time to time. However, its Celeron M Pentium III-based processor can benefit from a kernel that has been slimmed up by removing unneeded features, and compiled using the complete Pentium-III instruction set to make best use of available hardware.

In this episode, we will start hacking the kernel code itself, by making small changes in the source code and seeing what comes out of it. To start with something simple, but that can help give us some insight into the kernel source code internals, we will make some simple changes in the /proc filesystem. This also has the advantage of introducing the reader into one of the most used mechanisms that tell the system user about what is happening within the kernel.

THE PROC FILESYSTEM

We have already used the /proc virtual file-system in episode 3, “Configuring, compiling and installing the kernel” of this series, when we dumped file /proc/version_signature to see which exact kernel version we are running:

```bash
$ cat /proc/version_signature
Ubuntu 3.13.0-24.47-generic 3.13.9
```

To elaborate on this, it should be made clear that the /proc file-system - i.e. all files and directories hanging from this directory - do not have any real existence on disk.

This is contrary to “normal” files and directories such as /etc/passwd or /home that correspond to a specific location and data on your hard drive. When the user accesses one of these “real” files and directories, the kernel builds up internal data structures to represent an image in memory of the directory structure on the disk, using the routines defined in source directories fs/ext4, fs/btrfs, or similar.

In the case of /proc, the same data structures are built up in kernel memory, but without actually replicating an existing structure on disk. This is why they can be considered a virtual file system, since they retain the very same type of structure based on inodes as in a regular file system, but without accessing any data. Instead of which, the kernel will populate the (virtual) files with data from the kernel itself when files are accessed.

This is a quite flexible mechanism, since a file structure may be used to transfer data from the kernel to the user as in the above example, or may also be used to pass instructions from the user to the kernel itself, thus parameterizing the way it works while running. For example, network IP forwarding is off by default. On a computer that works as a router, forwarding between network interfaces may be turned on for IPv4 by issuing the command

```bash
# echo 1 > /proc/sys/net/ipv4/ip_forward
```

and for IPv6 with

```bash
# echo 1 > /proc/sys/net/ipv6/conf/all/forwarding
```

Default value ’0’ corresponds to the ’off’ state, while any positive value turns the option on. Naturally, we must act as root since we are altering the system configuration. This change will be applied only while the kernel is active; it must be re-applied after a system reboot.

ANATOMY OF A SIMPLE /PROC ENTRY

The /proc file-system is controlled by source code in the fs/proc subdirectory. To take a simple example, consider the code that generates the /proc/version file on the fly:

```bash
$ cat /proc/version
Linux version 3.13.0-24-generic (buildd@batsu) (gcc
```

"
This code is contained in source code file fs/proc/version.c. The complete source code (as of kernel version 3.13) is shown right.

Let's go over this part by part. The first few include lines include header files from source code directory include/linux/:
• <kernel.h> contains very basic macro definitions used across the source code.
• <init.h> contains initialization code, and specifically the code that we will use to initialize a module.
• <fs.h> contains basic definitions for any part of the file-system, such as codes to indicate file open for read and for write, etc.
• <proc_fs.h> contains similar code, but this time specific to the /proc file-system.
• <seq_file.h> defines common code for sequential file operations.
• <utsname.h> contains code to access specific kernel data from within user space.

This may seem over-complicated to programmers used to handling C code, since most of the file-oriented routines may also be found in standard C header files such as <stdio.h>. However, it should be noted that these standard I/O routines such as “printf” are actually compiled into the glibc library file – which the kernel cannot access from disk until the file system is ready. In fact, if mounting the boot drive does not work at all, the kernel may very well not have access to the standard C libraries, while at the same time needing very much to emit an error message to inform the user about what is going on! This explains why file access and outputting text on screen needed to be built into the kernel itself. Primitives are similar but not always identical to the more familiar glibc versions; for example, writing on screen is done with the “printf” command, though its syntax is in fact identical to “printf”.

Going down the code in file fs/proc/version.c, we see that the last line is

module_init(proc_version_init);

This is where the code
MODIFYING A /PROC ENTRY

The /proc/version file is perhaps not a very interesting proposition to modify. File /proc/cpuinfo spits out quite a lot of information that may allow more tweaking:

$ cat /proc/cpuinfo

[...]
processor : 3
vendor_id : GenuineIntel
cpu family : 6
model : 37
model name : Intel(R) Core(TM) i5 CPU M 460 @ 2.53GHz
stepping : 5
microcode : 0x2
cpu MHz : 2527.207

cache size : 3072 KB
[...]

(Some parts have been edited for brevity.)

All this information is given for each processor core present in the system. This can be nice to have to identify a CPU or its number of cores – without needing to peruse the documentation on the chip itself. However, I have always been a little dubious about the presentation. I would prefer to have less information, but more pertinent to my specific needs.

To find out how to change this, our first stop will be file cpuinfo.c in source code directory fs/proc. This file has a similar structure to version.c, except for the callback routine invoked when an open operation is performed on virtual file /proc/cpuinfo. In the case of cpuinfo.c, the procedure is called “cpuinfo_open”, and is simply defined as shown below.

This means we now need to find out where symbol “cpuinfo_op” has been pre-defined in the kernel source code. This can be searched out either using some imaginative configurations of the grep command.

```c
extern const struct seq_operations cpuinfo_op;
static int cpuinfo_open(struct inode *inode, struct file *file)
{
    return seq_open(file, &cpuinfo_op);
}
```
This is a quick modification of the original code written by the kernel developers.

The kernel now needs to be recompiled, and then reinstalled in the /boot directory and the GRUB entries updated. Since we have modified no modules, it shall not be necessary to recompile and reinstall them, so if we have already compiled the kernel at least once previously, the process needs to do less work this time and should complete rather more rapidly. So:

```
$ make
$ sudo bash
# make install
```

When tampering with file arch/x86/kernel/cpu/proc.c, we commented out the use of several of the existing functions. The compiler will complain with the following message:

```
warning: 'show_cpuinfo_core' defined but not used [-Wunused-function]
```

This is not a problem for our simple experiment, though if submitting code to the actual linux kernel project, it would be best to clean things up a little. Otherwise, you may get shouted at!

When compilation is over and the new kernel is installed, boot from it. No visible changes should be observed on the desktop - the two mushrooms were already there on the old kernel. Now re-examine the contents of /proc/cpuinfo. It should now correspond to whatever you put in proc.c:

```
$ cat /proc/cpuinfo
```

**CPU[0]:**
```
GenuineIntel Intel(R) Core(TM) i5 CPU M 460 @ 2.53GHz
2.527462 GHz
cpu cores : 2
[...]```

This is more compact, looks...
better and is more readable to my eyes.

In this part of our series on compiling the Linux kernel, we saw how to introduce small modifications into the kernel source code. The /proc virtual filesystem is a good place to start trying out our own code, at first just to obtain information from the kernel. Later on, the more adventurous could also try the inverse: tweaking the kernel's internal processes while running.

In the next - and last - installment, we will try out a new module, written from scratch and added to the default kernel source tree.

Alan teaches computer science at Escola Andorrana de Batxillerat (high-school). He has previously given GNU/Linux courses at the University of Andorra and GNU/Linux systems administration at the Open University of Catalunya (UOC).
**Graphically Renaming Files Over SSH**

**SH** is awesome. Tools like Midnight Commander (mc) are also really handy. Sadly, I’m a bit of a lazy admin and like to do some tasks graphically. A few days ago, I found that I needed to add text to the filename of a bunch of movies on my XBMC machine. I could have connected a keyboard and mouse to the machine (only an infrared receiver is connected to the USB port), logged out of the XBMC account, logged in to the openbox interface, and started renaming files, but I found a nice graphical tool to batch rename files. I just needed to figure a way to remotely mount the movie folder on our XBMC machine.

The answer was the sshfs package. I use Xubuntu on most of my systems, and sshfs is not installed by default. Installing software is one job I prefer doing from the terminal, it’s just quicker:

```
sudo apt-get install sshfs
```

Mounting a remote partition is easy once sshfs is installed. But first I’ll make a directory to work from:

```
mkdir ~/sftp
```

Now we’ll mount the remote file system. In this example, I’m going to use xbmc for the username on my XBMC remote server (which is called xbmc), and charles as my username on my local machine. Replace xbmc and charles with whatever username you use.

```
sshfs xbmc@192.168.1.10:/data/Movies /home/charles/sftp/
```

Notice that you do not have to sudo to mount the remote file system. You will, however, have to know the password for the user on the remote system. In this example, we mount the remote /data/Movies directory on the local /home/charles/sftp directory. You can also use the IP of your xbmc machine rather than the hostname.

```
sshfs xbmc@192.168.1.10:/data/Movies /home/charles/sftp
```

Now that we have the remote system mounted, we need a program to rename the files. Of course you can do this with mv and regular expressions, but I find that I have a bad habit of messing up and forgetting to do something so I end up with botched filenames. There are a few graphical tools to rename files, but the one that worked best for me was gprename.

One of the great features of gprename is the ability to preview your changes. I always preview changes in case I’ve messed up which letter/string to remove or add. Sometimes I also notice other things that also need changing while previewing.

In the screenshot example, below, I started with the idea that I would replace the small and in Harry Potter and the … with a capital And, but after previewing I noticed that I should also capitalize the T in The – so the filename matches with the rest of the Harry Potter series. I made the change and previewed again before I clicked the Rename button.
Renaming is just one of the functions you can do with GPRename. Sometimes it’s nice to add or strip out text. I’ve started to differentiate some of my media by adding the text DVD or Blu-ray to the end of the file. Just switch to the Insert/Delete tab to add or remove text. Unfortunately, gprename doesn’t know where the end of the filename is and the extension begins so you have to count out where you want the text. In the next graphical example, I add “- DVD” (a space, a dash, another space and the word DVD) to the 12th position in the filename.

If you have lots of files with text in the same spot that you want to get rid of, you can select the delete option and choose which positions to delete between. For example, if you have a bunch of music files that begin 1. song_name.mp3, 2. songname.mp3, 3. songname.mp3 you would delete 0 to 2.

Once you’re done, don’t forget to close gprename – or sshfs might not be able to unmount the filesystem. You cannot simply umount ~/sftp.

SSHfs uses fuse to mount the file system. To unmount ~/sftp use:
fusermount -u ~/sftp

Again you do not need to sudo because you’re mounting on your own home directory.

GPRename also works with directories. Regular expressions are more handy, but if you haven’t learned regexp, or are worried about messing up your files, use gprename and preview before you rename.

Charles is the author of Instant XBMC, and project manager of a not-for-profit computer reuse project. When not building PCs, removing malware, and encouraging people to use GNU/Linux, Charles works on reinventing his blog at http://www.charlesmccolm.com.
**Scilab description:** Scientific software package for numerical computations. Scilab is a matrix-based scientific software package. Scilab contains hundreds of built-in mathematical functions, rich data structures (including polynomials, rationals, linear systems, lists, etc...), and comes with a number of specific toolboxes for control, signal processing, etc. This package also provides Xcos, a graphical editor to design hybrid dynamic systems models. Models can be designed, loaded, saved, compiled and simulated. A stable and efficient solution for industrial and academic needs, Xcos provides functions for modelling of mechanical systems (automotive, aeronautics...), hydraulic circuits (dam, pipe modelling...), control systems, etc. Modelica capabilities are also provided.

I am totally blown away with the features available in Scilab, in my opinion rivalling Matlab, and definitely ahead of Octave (Octave’s new GUI should be released soon).

With any piece of software, the first thing I try to do is use the software to see how easy it is to use. Then I'll look at the help section to see how to do the things I want to do. If that does not suffice, I'll look at the documentation.

On ease of use, Scilab is as simple to use as a calculator. Just type in a calculation and press enter. Scilab can also do more involved mathematics such as finding the roots of polynomials.

Just search in the help section for roots. There is an example script that can either be viewed and executed from Scinotes (Scilab's text editor) or directly in Scilab.
There is a plethora of online documentation, online tutorials and websites available. A great website I used for control systems is Scilab Ninja. The Scilab for beginners guide, available from the Scilab Enterprises website, is also excellent.

By far my favourite part of Scilab is Xcos – the model diagram editor. It is Scilab’s version of Mathworks Simulink. It can model a number of systems from control engineering, to electric circuits and physical systems. The feature I found most useful is that Xcos can be integrated into Scilab scripts written in Scinotes to run model diagram simulations with given parameters.

To get a feel of what Scilab is capable of there is a demonstrations feature. There are many demos and it seems more will be added in the future.

Pros:
• Lots of features
• It’s free
• Easy to use
• Excellent help section and demonstrations
• Includes Xcos

Xcos doubles as a circuit simulator

**Cons:**
• Scilab crashes if you press enter without entering data
• Xcos crashes Scilab if block diagrams are given unknown references

**Conclusion**

Scilab is truly a marvel of free software engineering. I did not even begin to scratch the surface of the usefulness of Scilab for mathematics, engineering and physics. This software can and should be used in high-schools and universities. Scilab is far easier to learn and start using than Octave. Scilab is one of those software programs that makes you go wow! I can’t believe this is free. The occasional crash is the only thing costing Scilab a perfect review. I’m sure within the next release these minor issues will be sorted out.
**BOOK REVIEW**

Written by Mark Crutch

**BUILD YOUR OWN WEBSITE**

A COMIC GUIDE TO HTML, CSS, AND WORDPRESS

NATE COOPER WITH ART BY KIM GEE

Publisher: No Starch Press
Pages: 264, black & white
ISBN: 978-1-59327-522-8
http://www.nostarch.com/website comic

**Build Your Own Website** is very much a book of two halves; whichever way you slice it. Divide it by page count and you’ve got the beginnings of two very good books, one on HTML and CSS, and the other covering WordPress. Divide it by style and you’ve got a comic pastiche of The Wizard of Oz intermingled with a normal technical book. When gluing disparate styles and topics together, it can sometimes be hard to produce a coherent result. So did this book manage to combine everything cleanly, or is the result a bit of a jumble?

Since the book is billed as “a comic guide...” I’ll start with the comic. It follows the adventures of the comic’s artist, Kim Gee, as she attempts to create her first website, and is used to introduce the main themes of each chapter in a light-hearted and easy-to-read manner. The artwork is printed in black and white, and is perfectly functional if not particularly inspiring. This is definitely an educational comic, albeit one that doesn’t take itself too seriously. But it’s worth reinforcing that this is not a comic book for children, despite the colorful cover – not unless your kids are likely to prefer an educational tale about learning HTML to something involving Spiderman or My Little Pony.

Once Kim has completed each stage in her journey, the rest of the chapter reinforces what you’ve just learnt. It retreads the themes from the comic in more detail, and reads more like any ordinary technical self-help book would. These sections hold the bulk of the detail in the book, and are well written and easy to follow. If you’re an absolute novice at HTML and CSS, then over the first half of the book these sections should do a good job of getting you up to speed on the basics.

When you reach the chapter 4, however, the book changes tack significantly. Everything you’ve just learnt about HTML and CSS is swept aside in favour of using WordPress. There’s the occasional nod to the possibility of writing your posts in raw HTML, but the authors clearly think you should be using the visual editor instead. The rest of the book just covers the main parts of WordPress and how
to install it. I say “install it”, but don’t think you’re getting a run-down on PHP and MySQL in this book: the only options that are really considered are to use a wordpress.com account, or to find a host which offers a one-click install of WordPress as part of their package. There are some basic examples of three such hosts given, but these are all US-centric.

There are the beginnings of two good books here – but the endings of neither of them. Continuing the HTML and CSS to the full length of the book would have allowed for more complex examples, perhaps a little Javascript, and an introduction to the browser’s developer tools for debugging your site. A book this length on WordPress alone would have allowed the main topics a bit more breathing room, and given the opportunity to delve into more detail on some useful widgets, themes and plug-ins.

I find it hard to recommend this book, not because there’s anything particularly wrong with it, but rather because I don’t know who I would recommend it to. If you want to create a website, but don’t know enough to decide between coding it yourself or using WordPress, this might give you just enough insight into both approaches to make that decision. But if you already know which approach you want to take, then at least half of this book will be wasted on you, whatever your choice.
I have been using Linux for the last seven years, first five as a dual boot with Windows, and the last two solely dependent on Ubuntu. In the early days, I tried Redhat and Fedora, and with the live CDs I completely shifted to Ubuntu.

Being a doctor by profession, this was an odd combination (as many others found it nauseating to take the bitter pill and stay on the learning curve), but I always managed to find alternatives to the Windows software others used. The simplicity, stability and good reliable updates and the trustworthy community always were the blessings for me to stay on the track.

As my previous laptop died after 6 years of service (HP 9000 series), I bought a new one last year. This is a Dell 3521, coming with Intel core i3, 500GB HDD, 4GB RAM, hybrid graphics with AMD RADEON 7670M and Intel HD Graphics 4000, and Dell wireless 1704 (manufactured by Broadcom). This came preinstalled with Ubuntu 12.04 LTS so I kept it that way.

From the beginning, the wireless didn’t seem to function well. But I usually used a 3G dongle to connect to the Internet. So the wireless didn’t give me a problem in the early days. Once I bought my new Smartphone, I couldn’t connect it to the laptop via Bluetooth or wireless. Then I started to troubleshoot.

After doing a thorough search of literature in the community support, I started with reinstalling network manager, tried with different managers, and then handled the drivers. I tried reinstalling the existing ones, and then tried different suggestions given by the community.

On one fine day, when I was trying to fix the drivers, the wireless suddenly disappeared from the list. (I am so sorry I cannot post the link to the thread here, as I lost it with system reinstallation). I tried with “lspci” several times, and with reinstallation of default factory drivers. And then I tried with a live boot, but the result was the same. I decided to hand over the job to the shop where I bought the laptop, as the laptop was still in the warranty period.

What they did was installation of a trial version of Windows 7 and installation of drivers! And the wireless is working!!! And I could do all the stuff I wanted.

I felt bad about the situation. Why that happened and why we couldn’t solve the situation by ourselves is the main question I had so far. Why did we have a ‘long term support’ system if we couldn’t tackle problems for the next four years? And it would have been easy if we categorized and ranked the community threads.

I’m still using the trial version, and waiting impatiently to install 14.04. I wish everything would go fine and I could get rid of Windows. It’s always a bad dream to go back to Windows.
MULTIPLE PASSWORDS

The HowTo article in FCM#91 (page 16 and 17) sparked my interest. I downloaded the script and would like to learn how to use it. I know nothing about scripting. Don’t know if I will ever do much scripting, but I like to learn new stuff. I am looking at ‘Bash Guide for Beginners’ and have a question: What is an example of one entry in David Mawdsley’s password file.

At present I am using Lastpass to manage my passwords. I can export my passwords to a .csv file. If I copy and paste them into a text file, what comes first, second, etc, and separated by what?

Harold

David says: To get started, there are a few things to do so that the script from the article will work without modification:
1. On the desktop create a folder named “pw”.
2. Copy your .csv file to the folder with its name changed to "Personal" (with no .csv or quotes) – just the word – to allow the script to run unmodified.
3. Open Terminal on your computer with the 3-finger command ”Ctrl+Alt+T” (without quotes).
4. Install crypt with the terminal command ”sudo apt-get install crypt” (without quotes).
5. Save the script from the URL: http://fullcirclemagazine.org/wp-content/uploads/2014/11/multiple-password-script.txt to your home folder – with the file "multiple-password-script.txt” changed to a simple name such as "pwdir” (with no extension .txt – for typing ease).
6. Using Terminal, issue the command "chmod u+x pwdir” (without quotes), which will make the script able to run its commands.
7. Run the script in Terminal with "/pwdir” (without the quotes).
8. The first time, encrypt your file "Personal" using option 3 of the script. "cd” is to change directory. Type "Desktop/pw” (without quotes). (Don’t forget to write down the password that you use.)

At this point you should have "Personal.cpt” in your "pw” folder, and it’s encrypted. Now it’s easier to use Option 2 to decrypt and view "Personal” in gedit. When you close the text file "Personal”, you’ll finish up by the encrypting dialog. Finally close Terminal with the command "exit” (without the quotes).

EPUB

It is not a major crisis to me, but it is unusual that the first character in each article in the epub version I read is set one line up from the first sentence?

I am using Android Nexus 7 (WiFi) (2012) with Android 4.4.4 to run the latest Aldiko Pro to do my reading with.

Alf Stockton

Brian says: Thank you for bringing this to my attention. The first letter of each article is usually a drop cap which Aldiko is showing as a single letter on a separate line.
Welcome to another edition of Letters.

Python makes a triumphant return this month I’m afraid. I’ve found a couple of interesting problems that I thought I’d share.

Aldiko, by default, expects epubs to be generated by Adobe Indesign, which, by default, does not explicitly support drop caps although by a bit of magic can be made to do so: https://www.video2brain.com/en/lessons/adding-drop-caps

I usually check out the epub version in Moon+ as it is my preferred reader on Android, and, of course, it displays as I expect it to.

A fairly recent and comprehensive review of the advantages and disadvantages of several readers can be found at http://blog.fogdo.net/archive/ebook_readers_the_android_way.html. It’s long but worth a read.

This table from that site shows the abilities of various readers to display the first character:

<table>
<thead>
<tr>
<th>Name</th>
<th>CSS</th>
<th>Local</th>
<th>Local override CSS</th>
<th>XHTML</th>
<th>Embedded Fonts</th>
<th>first-letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aldiko</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Bluefire Reader</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Captinary eBook Viewer</td>
<td>no</td>
<td>yes</td>
<td>–</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>CoolReader</td>
<td>no</td>
<td>yes</td>
<td>–</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>ePub Reader for Android</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>FBReader</td>
<td>no</td>
<td>yes</td>
<td>–</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Foliant</td>
<td>no</td>
<td>yes</td>
<td>–</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Kindle</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Kobo eBooks</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Mantaro Reader</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Moon+</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Nomad Reader</td>
<td>no</td>
<td>yes</td>
<td>–</td>
<td>no()</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Wordholic Reader</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>StarBooks</td>
<td>yes</td>
<td>?</td>
<td>?</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Whilst this review is outdated, the comments and findings pretty much hold today.

A similar problem can occur when using Calibre to convert files for the Kindle. If the choice is MOBI, then the drop cap appears on a separate line. If the choice is AZW3 then it is displayed correctly.

Because of the problems that a different format for the first character in an article causes in so many epub readers, it makes sense to discontinue its use from now on. Maybe it will come back when more widely and consistently supported. So from Issue #92, there will be no special first character for articles in the EPUB version.

It is possible to edit the files using Calibre, Sigil, or a text editor to change the lines like

<p class="dropcap">P</p>

<p class="text">Python makes a triumphant return this month………………</p>

Changing reader app.

Thanks again for your feedback which is very helpful and thought-provoking.

In each article but I doubt that many readers would want to bother.

It is a problem similar to different Web Browsers displaying content differently – which seems to being slowly resolved as they converge on a common standard kicking and screaming.

I did research to find a simple solution for you, but ran into a brick wall other than to suggest changing reader app.
Q Can I extract an image from a PDF and save it as a jpg?

A Yes, open the PDF in Gimp, and tell it what page the image is on. Then you can "save as." Gimp may prompt you to "flatten the image," so just do as it asks, then "save as."

Q Where are the 13.04 package repositories?

A 13.04, and 13.10, had just nine months of support. The current supported releases are 12.04, 14.04 and 14.10.

Q I want to install the latest unetbootin in Ubuntu 14.04.

A (Thanks to NerdtroN in the Ubuntu Forums) The latest one compatible with Ubuntu 14.04 is unetbootin 603. Here’s a download link:
http://unetbootin.en.uptodown.com/ubuntu/download/77793

Now go to the Downloads

Q Today I installed Ubuntu 14.04 LTS next to my Windows 7 Professional. The first thing I noticed was that my mouse, plugged into my only USB 2.0 port, was not working. It’s a Razer Naga, which has coloured LED flashing when it is powered, and it was all dark. So I plugged it into the 3.0 port, and it worked right away.

A (Thanks to Morgaes in the Ubuntu Forums) This is fixed in Ubuntu 14.10.

Q How can I check on whether the process myproc is running?

A Enter the following command:

```
ps aux | grep myproc
```

Q You will always get at least one line of output, so ignore the last line.

Q What is the easiest way to find the IP address of a domain?

A Use the host command, eg:

```
host ubuntu.com
```

Q What is the easiest way to get all my applications onto a new machine?

A Everything you have installed or updated is in /var/cache/apt/archives – unless you have run apt-get clean.

You could delete the old versions for which there has been an update, then copy your applications to your new computer and install each of the programs.

---

**TOP QUESTIONS AT ASKUBUNTU**

* Making Ubuntu Download Bootable from USB
http://goo.gl/yqj3rD
* What’s wrong with using sudo?
http://goo.gl/Im6Ylk
* How to "cat" or "less" a libreoffice writer .odt file?
http://goo.gl/4wUMXs
* Dividing an existing Ubuntu installation on two physical drives
http://goo.gl/NBGPci
* How to get the path to a file in your system
http://goo.gl/C22KGq
* How to back up with terminal
http://goo.gl/zMxEkP
* How do rootkits get installed on to a ubuntu server?
http://goo.gl/IoMEvD
* How do I type an 'ae' character?
http://goo.gl/c53Hb0
* Add column from one .csv to another .csv file
http://goo.gl/GveRJF
Every computer survived the move. We knew that if we didn’t have backup, it would lead to a catastrophe.

One of the areas the carpenters didn’t have ready was for the receptionist, at the front door. We installed an old laptop, running Linux, with a webcam, so she can see what’s happening at the front door from her Windows PC at her temporary location. X11vnc rocks.

The first floor has three rooms for meetings with clients, and the boss wanted them to have cool technology. We went with wall-mounted Samsung smart TVs, with cables in the wall going to a hidden Zbox PC. The Zbox is tiny! Then we added wireless keyboard and mouse combos, so all the client sees is the TV, apparently operated from a disembodied keyboard and mouse. There are many configurations of Zbox; we went with the ID91 Plus, which has a fairly fast Core i3, 4 GB of memory, and 500 GB hard drive. The tiny Zbox sure works nicely.

The Zbox comes with no OS, and when I booted from a Mint Live CD, it all worked. It has two gigabit Ethernet ports, so I tried installing pfSense, the world-class free firewall/router software. It worked great!

You can also buy versions with no memory and no hard drive. Get the one with an i5, add 16 GB of memory and a big SSD, and you have a powerhouse. It’s not particularly cheap, but hugely cool.
If you’ve been following my previous X-Plane tutorials, then you should have an awesome looking X-Plane with real-time tracking and all sorts of whizz-bang effects.

But what about a flight plan?

Actually creating a flight plan is easy enough: the X-Plane Flight-Planner website: http://xplane.anzui.de:3000/flight-planner.

On the site (using the small ‘+’ icon), you can show/hide various overlays such as routes, fixes, airports, etc. You can also change the map type from roads to satellite, or even use the Openstreet map.

The blue (and pale blue) circles with what looks like an ‘X’ are airports, while the blue circles with a white ‘H’ are heliports. The white triangles are fixes. You can click any of them to get a popup with info. Airports will give you info such as radio frequencies and their name (eg: EGPF), while the fixes will just have a name (eg: GOW12).

Let’s say I’m flying out of Glasgow airport and ultimately want to land at Edinburgh, but want to go via a fix. In other words: I don’t want to just go in a straight line from A to B.

First, I click Glasgow airport, and click the link that says ‘add as waypoint’:

As you can see, it’s added Glasgow (EGPF) to the column on the right. Next, I click Edinburgh, and do the same:

That’s better. You can click the EDIT button at the top right to enter information such as aircraft, fuel, etc. But let’s keep it simple for now.

NOTE: If you’re using a plane with a flight management computer (FMC) that allows importing of flight plans, then you can use the EDIT button to export your flight plan as a .FMC file.

So, none of that was done in X-Plane. Now what? Well, time to load up X-Plane, and hop inside your favourite plane, and click the Garmin GPS. It should open in a
new window within X-Plane:

Unfortunately, the Garmin/X-Plane 530 is a bit awkward to use since it has no keys. Everything has to be done using the two revolving dials on either bottom side of it. Like radio buttons, there’s a larger outer dial, and a smaller inner dial. Each also has a push button in the middle.

First, press CDI and make sure VLOC becomes GPS. I prefer GPS over VLOC. Now, press FPL. As it says, this is your active flight plan. At the moment it’s empty. But, press the middle of the right dial, then click the inner smaller dial to begin entering your starting point. After the first letter, click the larger dial to enter the next letter, and so on. In my case I’m entering EGPF. When entered, press ENT.

ACCEPT? Press ENT to accept.

Now you have your starting point in. Do the same thing for the fix and the destination.

Pretty fiddly, huh? Well, fear not, it’s almost done, and, once it’s entered, you’ll have the pleasure of enjoying auto-pilot.

Press FPL again, and you’ll go to the radar/map mode. You may need to use the up/down button at the top-right to zoom in/out, but you should see that you’re at your starting airport with a line drawn to the fix, then to your destination.

So, with your flight plan in the GPS, it’s time to fire up your bird, and enable the autopilot, and enjoy the view!

There’s still a lot more that the Garmin 530 can do. You can program it for a specific approach where it’ll pretty much line you up and all you need to do is slow down, go into approach mode, and get your wheels on the tarmac.
I’m using Ubuntu 14.04(LTS). I love simplicity, and my desktop contains the following customization:
• Numix icon circle theme
• Harmattan conky
• Numix GTK theme
• Indicators like netspeed indicator, hardware sensor indicator, clipboard, uget

• and last one...wallpaper: http://goo.gl/9zh28p

Arpan Chavda
My laptop is a Lenovo ideapad S110, 2GB RAM, Intel Atom, and a 16 GB SD card as the Hard Drive (I broke my 320GB).

My OS is Lubuntu 14.04.1 LTS, and it’s a very great OS. It’s faster than Unity/Gnome, doesn’t load itself in RAM unlike Puppy, not buggy compared to Bodhi/Enlightenment, and more colorful than CTRL+ALT+F4. A true alternative to Windows XP!

The widget is Lubuntu-dark-panel, Icon Theme: Humanity, Window Border Theme: Lubuntu-default. The wallpaper is Game of Thrones inspired.

reezeylon escabal
FULL CIRCLE NEEDS YOU!
A magazine isn’t a magazine without articles and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: reviews@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

FCM#89

Full Circle Team
Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert Orsino, Josh Hertel, Bert Jerred, Jim Dyer and Emily Gonyer

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker